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1. Introduction 

1.1 Welcome to Pocket NiceLabel 

Thank you for choosing Pocket NiceLabel, the industry‟s leading bar code 

labeling and printing software for Windows-based mobile devices! 

The new version 5 of Pocket NiceLabel is a complete .NET rewrite and 

features many improvements from previous Pocket NiceLabel versions. 

Pocket NiceLabel version 5 supports Microsoft Compact Framework 2.0, 

has a smaller deployment footprint than in previous versions, consists of 

one Pocket NiceLabel application that can now print form files (no longer 

separate Pocket NiceForm application is installed), and comes with an 

enhanced synchronization utility that replaces the old Synchronization 

Manager. 

This guide introduces you to using Pocket NiceLabel and printing bar code 

and RFID smart labels through Mobile Devices. You will learn how to 

install and register Pocket NiceLabel software on your Mobile device, 

design labels with NiceLabel Pro and NiceFrom on your desktop computer, 

transfer the label files to your Mobile Device, and print bar code labels with 

mobile thermal printers or through a server-based network environment. 

1.2 Pocket NiceLabel Overview 

Pocket NiceLabel enables you to create robust data entry screens for your 

Mobile Device. With the help of Pocket NiceLabel users can print bar code 

labels directly with Windows Mobile Devices that are connected with 

thermal printers through WiFi, Bluetooth or serial cable. In addition, 

Pocket NiceLabel enables bar code label printing in a network 

environment. Using NiceWatch, you can print bar code labels to a 

centralized print server that handles printing and driver selection. Pocket 

NiceLabel and centralized printing through NiceWatch (called Distributed 

(Print Server) Printing Method) offer a truly mobile distributed printing 

application. 
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Pocket NiceLabel can also be used as a print engine (.NET Assembly) to 

enable other applications on your Mobile Device to control label printing 

functions. Using Pocket NiceLabel as a print engine appeals to system 

integrators and software developers who wish to use Pocket NiceLabel as a 

label printing module for their mobile applications. For more information 

about using Pocket NiceLabel as a print engine in a customized mobile 

Windows application, please see the NiceLabel Web site at 

www.nicelabel.com. 

1.3 NiceLabel Editions Supporting Pocket NiceLabel 

Pocket NiceLabel is part of two NiceLabel products that are dedicated to 

simple mobile printing application design: NiceLabel Pocket PC Designer 

and NiceLabel Suite. Both products enable mobile printing through a direct 

connection to mobile printers (direct printing method) and client/server 

connections with server based database lookups (distributed (print server) 

printing method). 

1.3.1 NiceLabel Pocket PC Designer 

NiceLabel Pocket PC Designer enables you to create mobile printing 

applications that print directly from the Mobile Device to the printer 

through Wi-Fi (TCP/IP), Bluetooth or COM (serial) communication. 

NiceLabel Pocket PC Designer includes the following: 

 NiceLabel Pro: WYSIWYG label template design for over 900 

optimized thermal label printers. 

 NiceForm: A limited version of the standard NiceForm that allows 

rapid user interface design for a Mobile Device only. Interface 

design for a desktop computer is not enabled. 

 Pocket NiceLabel: A mobile client that executes the label and form 

designs that were created on a desktop computer. 

1.3.2 NiceLabel Suite 

NiceLabel Suite enables you to create mobile printing applications that 

print directly from the Mobile Device to the printer or through a server 

when used with the NiceWatch print server. NiceLabel Suite includes all 

features of NiceLabel Pocket PC Designer plus the following: 
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 NiceForm: A full version of the standard NiceForm that will allow 

rapid user interface design for a Mobile Device as well as for a 

desktop computer. 

 NiceWatch: A centralized print server for automating label printing 

operations. NiceWatch accepts a print request from any mobile 

wireless, desktop, ERP or WMS application to automate label 

printing without user intervention. Print requests can be made 

through a file drop, TCP/IP socket, COM port or email trigger. 

 NiceMemMaster: Utility to download true type fonts and graphics 

to a printer's internal memory to enhance printing performance for 

thermal printers. 

 NiceData: A powerful database manager to create and edit database 

tables and import data from text files to database tables. 

 NicePrintQueue: A print job management module that provides 

overview of print jobs, data used on the label and quantity of printed 

labels. All data is stored for easy re-prints of past print jobs. 

1.3.3 NiceLabel Print Center 

The NiceLabel Print Center is the enterprise solution for client-based label 

printing and centralized system management. The NiceLabel Print Center 

enables users to initiate label design and printing on different local clients 

and to manage them from a centralized location. 

NiceLabel Print Center includes all features of NiceLabel Suite plus the 

following: 

 Enterprise Print Manager: A web-based module installed on the 

Web server that you can access from any workstation on your 

network or through the Internet to manage your printing process on 

your network clients. 

1.4 Setup and Test Mobile Device 

Before you install Pocket NiceLabel, you have to familiarize yourself with 

your Mobile Device. You must know what processor type and what 

Windows CE operating system your device uses. In addition, you have to 

establish functioning communication between both your desktop computer 

and your Mobile Device through an established ActiveSync partnership and 
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between your Mobile Device and a (thermal) label printer through serial 

cable, WiFi or Bluetooth.  

Please refer to the documentation of your Mobile Device to learn more 

about processor, operating system and how to establish different 

communication modes. 

1.5 About this Manual 

The Pocket NiceLabel Quick Start Guide helps you design and print labels 

quickly with a Mobile Device. The Pocket NiceLabel Quick Start Guide is 

an excerpt of the complete NiceLabel User Guide that you can obtain on 

the NiceLabel CD or online at www.nicelabel.com. 

1.5.1 Typographical Conventions 

Text that appears in bold refers to menu names, file names like 

SETUP.EXE and buttons like the OK button. 

Text that appears in italic refers to confirming actions like Read only and 

locations like Folder. 

Text enclosed in <Less-Than and Greater-Than signs> refers to keys from 

the desktop computer keyboard like <Enter>. 

Variables are enclosed in [brackets] like [variable]. 

1.5.2 Software Restrictions 

All features explained in the Quick Start Guide are available in the 

NiceLabel Suite edition. However, sections discussing NiceWatch setup 

(distributed printing method) do not apply to users using the NiceLabel 

Pocket PC Designer. The NiceWatch  icon will alert you that you must 

have NiceLabel Suite to be able to implement these features. 
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2. Installing Pocket NiceLabel 

Before you install Pocket NiceLabel, make sure you have the following: 

 NiceLabel CD-ROM 

 Pocket NiceLabel Quick Start Guide  

 Client Access Number (25-digit Software Key) 

2.1 System Requirements 

To work with Pocket NiceLabel, you need to have the following: 

1. Desktop computer to design labels and forms meeting the following 

requirements: 

 Pentium based computer with at least 64 MB of free RAM. 

 One of the 32-bit Windows operating systems: Microsoft Windows 

2000, XP, 2003 or Vista. NiceLabel also supports 64-bit Windows 

operating system. 

 Hard disk with 50 to 250 MB of free disk space (depending on the 

installation options). 

 CD-ROM drive. 

 Support for OLE DB database drivers. Recent Windows operating 

systems have included OLE DB database drivers. If your operation 

system does not have the database support, the installation wizard 

will prompt you to install it. 

 Administrator rights to the local computer during installation. 

2. Windows Mobile Device meeting the following requirements: 

 At least 8 MB RAM.  

 Installed ActiveSync Version 3.5 or higher. 

 Microsoft .NET Framework Version 2.0 (included on NiceLabel CD-

ROM) 
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 One of the following Windows operating systems: 

 Windows Mobile 2003 and 5.0 

 Windows CE.NET 4.2 and 5.0 

Pocket NiceLabel works on all devices with Microsoft‟s .Net Compact

 Framework 2.0 installed. 

3. NiceDrivers 

 Required for Direct Printing Method. 

 Not Required, but recommended for Distributed (Print Server) 

Printing Method. 

2.2 Software Installation 

Please note: If your desktop computer runs Windows NT, 2000 or XP, you 

have to log on with administrator rights to be able to install the software 

properly. Furthermore, you must ensure that your Mobile Device works 

properly, including file synchronization with ActiveSync and any printing 

capabilities your Mobile Device supports. 

If your Mobile Device does not have installed Microsoft Framework 

version 2.0, the Pocket NiceLabel installation wizard will install Microsoft 

Framework version 2.0 before it installs Pocket NiceLabel. 

To install Pocket NiceLabel on your Mobile Device, do the following 

steps: 

1. Connect your Mobile Device to the desktop computer.  

2. Make sure that an ActiveSync partnership is established between the 

desktop computer and Mobile Device. 

3. Put the NiceLabel CD-ROM in your CD drive. The START.EXE 

application will start automatically. If not, go the folder „X:\‟ and click 

on the file Start.exe („X‟ stands for the letter of your CD-ROM drive). 

The window NiceLabel Product CD will open. 

4. Click on Install. 

5. Click on Pocket NiceLabel (CE.NET). 

6. Click on Pocket NiceLabel and follow the prompts. 

7. Follow the prompts to finish the installation. 
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8. If Pocket NiceLabel installation on your desktop computer is complete, 

ActiveSync will start and transfer the necessary files to the Mobile 

Device. Follow the prompts on both the desktop computer and Mobile 

Device. 

The Pocket NiceLabel application will be stored in the folder \Program 

Files\Pocket NiceLabel. Pocket NiceLabel will also appear in the Start\ 

Program menu of your Mobile Device. 

 

Note:  If you want to install Pocket NiceLabel on more than one Mobile 

  Device from the same desktop computer, the installation wizard 

  will uninstall Pocket NiceLabel from your desktop computer and 

  reinstall it again before it installs Pocket NiceLabel on the Mobile 

  Device. Just follow the prompts of the installation wizard. 

 

2.3 Demo Mode 

After you have installed Pocket NiceLabel on your Mobile Device, Pocket 

NiceLabel will open in DEMO mode. The DEMO version of Pocket 

NiceLabel allows you to print only one (1) variable field per label. You will 

also see a DEMO warning between each print request. 

Please note that you should use the DEMO version only to evaluate the 

software. Any commercial use of the DEMO software is prohibited. To 

obtain the full working version of Pocket NiceLabel, you have to activate 

the software with the 25-digit Client Access License (CAL) number 

provided at the time of purchase of Pocket NiceLabel. 
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3. Activating Pocket NiceLabel 

The licensed version of Pocket NiceLabel comes with a 25-digit Client 

Access License (CAL) number that releases the application from DEMO 

mode and enables you to print labels without limitations from your 

Windows Mobile Device. 

To activate Pocket NiceLabel on your Windows Mobile Device, do the 

following steps: 

1. Open Start/ Programs/ Pocket NiceLabel folder/ Pocket NiceLabel 

(or Pocket NiceForm). 

2. Read the DEMO warning and tap the YES button. 

 

 

 

 

 

 

 

 

 

 

 

 

3. Enter the required information into the registration dialog box on the 

Mobile Device and tap the OK button. 

 

 

 

Demo Warning Pocket NiceLabel 
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Activating Pocket NiceLabel with your Mobile Device will remove the 

DEMO mode limitations. The CAL number you received with your initial 

NiceLabel software is only valid for one (1) Mobile Device. If you want to 

use Pocket NiceLabel with more than one Mobile Device, contact your 

NiceLabel reseller to upgrade the Client Access License for multiple 

devices. 

Activating Pocket NiceLabel 
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4. Designing Labels for Pocket 
NiceLabel

1
 

Creating a label for your Mobile Device requires two steps: First, you need 

to design a label or form with NiceLabel Pro or NiceFrom on your desktop 

computer. Second, you need to transfer the label or form to your Mobile 

Device. To learn more about the differences between labels and forms 

designed with NiceLabel Pro and NiceForm, go to the NiceLabel web site 

at www.nicelabel.com and see the NiceLabel User Guide (under 

Downloads/ Manuals) or tutorials (under Support). 

The following section will discuss how to design labels and forms for 

Pocket NiceLabel using both NiceLabel Pro and NiceForm. 

 

TIP: Before you start designing a label, create a synchronization folder

  on your desktop where you save your label for the Mobile Device. 

  You will synchronize the files in the synchronization folder with 

  your Mobile Device. 

 

Note on printing method: Before you start designing the label for your 

Mobile Device using NiceLabel Pro, make sure you understand the 

different label design restrictions between the Direct Printing Method and 

the Distributed (Print Server) Printing Method. 

 

Direct Printing Method: You print labels directly from the Mobile Device 

that is connected to the printer through Bluetooth, WiFi or serial cable. 

With the direct printing method consider the following requirements when 

you design your label: 

 Only text and bar code objects can be linked to variables. 

                                           
1
 The following instructions are based on and were tested with Unitech Windows CE.Net v4.2, Unitech PocketPC 

v4.20, HPP PocketPC (Windows Mobile 2003) Mobile Devices and Zebra R4Mplus and Sato CL408e printers. 
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 Only use native (printer resident) fonts for all the variables on the 

label. Exporting to Pocket NiceLabel does not support variables in 

true type font (unless you use NiceMemMaster to download true 

type fonts and graphics to your printer's internal memory to enhance 

printing performance for thermal printers. See Online Help of the 

NiceMemMaster module for more information). 

 Use only printer internal counters on the label. Exporting to Pocket 

NiceLabel does not support NiceLabel variable counters. 

 Select the printer you will print the labels with in the field at the time 

you design the label. The generated .LVX file only works with the 

selected printer because native language compliance is required at 

the time of label design. 

 

Distributed (Print Server) Printing Method: You print labels from the 

Mobile Device to NiceWatch, which handles printing and enables selection 

of different printer drivers. Pocket NiceLabel becomes a client to 

NiceWatch. When you design a label using the print server method, you 

can use true type fonts for both fixed text objects and objects using 

variables. 

4.1 Supported Functions in Pocket NiceLabel 

Pocket NiceLabel supports the following functions: 

 Concatenation 

 Date Addition 

 Internal Printer Counters 

 Internal Printer Clock (Date/ Time) 

 EAN.UCC 128 

 Linear 

 Subset 
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4.2 Design Mobile Device Labels with NiceLabel Pro 

Open NiceLabel Pro on your desktop computer and design a label using the 

following objects
2
: 

 Text objects with Fixed Text in true type fonts. 

 Text objects with Keyboard Input variables in native font. 

 Native Bar Code object with Keyboard Input variable. 

 Text object with New Date Field in native font. 

 Fixed Picture object. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note:  Please make sure of the following: 

 All text objects using keyboard input variables (showing 

variable names in yellow) must use printer native fonts in 

order to work with Pocket NiceLabel. NiceLabel shows all 

                                           
2
 For more detailed information on how to design labels using NiceLabel Pro, look at the NiceLabel Quick Start Guide 

(included in your product box or available as a PDF file on your NiceLabel CD or at the NiceLabel web site at 

www.nicelabel.com). 

 

 

NiceLabel Design – Data and Variable View 

Text Object  
(Keyboard Input; 
Printer Native Font) 

Fixed Picture 

Date Field Object  
(Text Object, Key-
board Input; Printer 
Native Font) 

Bar Code Object  
(Keyboard Input; 
Printer Native Bar 
Code) 

Fixed Text 
Object 
(True Type Font) 
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native font types with a printer icon in the font name drop 

down menu (see figure below). 

 Use unique variable names that identify the variables; 

however, do not use a space in the variable name (for 

example, use ProductID instead of Product ID). 

 Select the printer you want to print the label with your 

Mobile Device at the time you design the label. You have to 

install the printer driver (NiceDriver) on the  computer you 

design the label with even though the printer is not 

connected to that computer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Native Font Menu  
(Printer icon 
indicates native 
fonts of the 
selected printer) 
 

NiceLabel Pro Designer – Printer Native/ Resident Font 
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4.3 Transfer Labels to Mobile Device 

After you have designed your label, you need to transfer the label to your 

Mobile Device. If you have not done so already, you should create a 

synchronization folder on your desktop where you save your label for the 

Mobile Device.  

Synchronize the files in the synchronization folder with your Mobile 

Device by doing the following steps: 

1. Save the open label file on your desktop with NiceLabel Pro. 

2. In NiceLabel Pro, go to File/ Export/ Export to Pocket PC… 

An Information window will open telling you that the export function 

 has been completed successfully. 

3. On your desktop computer, open the folder My Documents/ My Labels/ 

Labels. 

4. Copy the two label files with the suffixes .LVX and .PNL to the 

synchronization folder of your Mobile Device. 

 

 

 

 

 

 

 

 

 

 

5. Connect and synchronize your Mobile Device with your desktop 

computer. 

6. Open the folders My Documents/ My Labels on your Mobile Device and 

check if both .LVX and .PNL files have been synchronized successfully. 

 

 

 

Exported Pocket NiceLabel Files 
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You should now be able to open and print the label with your Mobile 

 Device using Pocket NiceLabel. 

Note: You cannot change the label using Pocket NiceLabel on your  

  Mobile Device. If you want to change the label for your Pocket 

  NiceLabel, you have to make the changes with NiceLabel Pro on 

  your desktop computer, export the revised file and transfer it to  

  the Mobile Device  again. Make sure that you delete the old file  

  from the memory of your Mobile Device first before you transfer

  the new label (.PNL and .LVX) files from your desktop computer 

  to the Mobile Device. 

4.4 Design Mobile Device Forms with NiceForm 

This section will discuss how to use NiceForm to design a basic Mobile 

Device label and a Mobile Device label connected to a database. You can 

create a form both ways: either start with a blank form and create the form 

manually or use a label template created with NiceLabel Pro first and 

convert the template to a form.  

The following section uses a label template created with NiceLabel Pro as 

the starting point for creating a form. The form will use Combo Boxes for 

Exported Files on Mobile Device 
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the existing variables so that the operator in the field can select the data 

from a pre-defined drop-down menu. 

 

Note: If you design a form for Pocket NiceLabel, your Mobile Device 

  determines what features of NiceForm can be used or not. In  

  general, all Pocket NiceLabel certified Mobile Devices support  

  the following NiceForm objects and features: 

 Text, Button, Edit Field, Memo Field 

 Combo Box and List Box 

 Table 

 Database Navigator and Database Search 

4.4.1 Design a Basic Form  

To design a basic form, do the following steps: 

1. Open NiceForm on your desktop computer. 

2. Start the  New Form Wizard or go to the File menu and select New/ 

New Form Wizard. The New Form Wizard will open.  

3. Read the summary and click on the Next button. 

4. Select Mobile Windows application and select the platform (VGA 

screen size) of your Mobile Device. Click on the Next button. 

5. Click on the  button and browse to the label template you created 

with NiceLabel Pro (here: pocketnl-label.lbl).  

6. Select Use default template. A new window will open. 

7. Select Vertical arrangement of the object and click on the Next button. 

A new window will open. 

8. Select Top arrangement of the captions and click on the Next button. A 

new window will open summarizing your selection. 

9. Click Finish to submit the settings and the form will be generated. A 

new window opens showing the form similar to the figure below:  

 

 



 Chapter 4: Designing Labels for Pocket NiceLabel 

 

 

Pocket NiceLabel Quick Start Guide 19 

 

 

 

 

 

 

 

 

 

 

 

Note:  The form shows the 3 Keyboard Input prompts with the 

   variable names and created as a default feature three  

   additional objects: Quantity Keyboard Input object, Print  

   and Quit buttons. 

 

TIP: You can define the order for the TAB button and set the tab Order 

 in which the Data is entered 

a. Select the command Tab order in the Design menu. 

b. Select the order of the objects. 

c. Click on the OK button. 

d. Select Run in the Design menu to start the form. 

e. Test the behavior of the tab order. 

As the user presses the <Tab> key, the focus advances from one 

 object to the other. The next object in the tab order is selected and 

 becomes active. 

 

10. Save the form by clicking on the  button or select command Save 

from the File menu. 

Note: All forms of Pocket NiceForm are saved as an .XFF file on the 

 desktop computer and saved as a .PFF file on the Mobile Device. 

 

 

 

Form Based on Label Template 

Edit Field and Buttons 
Added by NiceForm 
automatically. 

Variable Text Objects 

Prompts with variable names 
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TIP:  If the printer you selected on the label template is connected to  

  your desktop computer, test-print the form from your desktop  

  computer and do the following: 

a. Run the form by clicking on the  button or selecting the 

Run command in the Design menu. 

b. Type in the values for the variable fields on the form. See how 

the label preview refreshes for each entered data.  

c. Click on the Print button to print the label to the default 

printer.  

d. Click on the Quit button to close the running form. 

4.4.2 Create Combo Box on the Form 

Change the Variable fields on the label template to Combo Box fields 

Before you synchronize the form with your Mobile Device, replace 

prompts Edition, ProductID and Version with a Combo Box. A Combo 

Box has a defined list of values you can select to print on the label. You 

will have to enter the information for that field manually (or scan) at print 

time. Using a Combo Box makes keyboard entry in the field with the 

Mobile Device easier and faster than typing each value with the keyboard 

tab. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Form Based on Label Template 

Edit Field and Buttons 
Added by NiceForm 
automatically. 

Variable Text Objects 

Prompts with variable names 
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To create a Combo Box, do the following steps: 

1. From the Toolbox menu, select Combo Box/ Use Existing Variable/ 

Edition and click on the form. 

2. Double-click on the Combo Box you placed on the form and a window 

with the Combo Box Properties will open. 

3. Open Contents tab and select Variable Value and Edition. 

4. Open Values tab and click on the Edit button. A new window Edit 

Items will open. Do the following:  

a. Select Use Custom Values in the drop-down menu. 

b. Enter the list of items you want to 

select from at print time (one item 

per line). 

c. Click on OK button twice. 

5. Replace (delete) the original variable field 

with the new Combo Box. 

6. Repeat steps one (1) to five (5) for the 

variable fields showing prompts 

ProductID and Version. 

7. Save the form by clicking on the  button or select Save from the File 

menu. 

Note: All forms for Pocket NiceForm are saved as an .XFF file. 

TIP:  If the printer you selected on the label template is connected to  

  your desktop computer, test-print the form from your desktop  

  computer and do the following: 

a. Run the form by clicking on the  button or selecting the 

Run command in the Design menu. 

b. Type in the value for the first variable field (Key Number) and 

select the item from the Combo Boxes.  

c. Click on the Print button to print the label to the default 

printer.  

d. Click on the Quit button to close the running form. 

Form with Combo Boxes 
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4.4.3 Design Form with Database Connection 

You can link a form to any kind of database or Excel worksheet, 

synchronize the form and database files to and print the form with your 

Mobile Device. To design the form for you Mobile Device that is 

connected to a database, do the following steps: 

a) Create a Microsoft Access database with two (2) tables: NiceLabel 

Products and NiceLabel Version. 

b) Link the Combo Text objects on the form to the database. 

 

 

 

 

 

 

 

 

Create a Microsoft Access Database with the following tables and content: 

1. Table NiceLabel Products 

with columns for product 

edition and product code 

(see figure): NL Express, 

NLE; NL Pro, NLP; NL 

Pro Print Only, NLPPO; 

etc. 

2. Table NiceLabel Version: 

3.6.4, 3.6.5, 4.0.0, 4.0.1, 

4.1.0, 4.1.1, 5.0.0, 5.0.1, 

5.1.0 

 

 

 

 

Access Database with 2 Tables 

Access Database Table NiceLabelProducts 
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To connect the form to a database using a Combo Box, you must create 

database access functions that define a link to your database and create 

objects that use the data from the database. 

 

To create database access functions, do the following steps: 

1. Open the form above with NiceForm on your desktop computer. 

2. Go to Data/ Database Access in the menu bar. The window Database 

Access Functions will open. 

3. Click on the Wizard button and a new window will open. 

4. Click on Next and the window Database Wizard – Browse for 

Database file will open. 

5. Select Direct database access and browse for the Access database file 

in your directory.  

6. Select NiceLabelProducts in the drop-down menu and click on the 

Next button. A new window will open. 

7. Select I will link the database fields to the objects myself later and 

click on the Next button. A new window will open summarizing the 

steps you have completed. 

8. Click on the Finish button. The open window Database Access 

Functions will now show the link NiceLabelProducts. 

9. Repeat steps three (3) to eight (8) but select NiceLabelVersion in step 

six (6) to create a link to other table of the database. 

10. When you have established a link to all tables, the window Database 

Access Functions should show all two (2) links. See figure below. 

11. Click on the Close button. 
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To link the database tables to a Combo Box on your form, do the following 

steps: 

1. Double click on the Combo Box Edition. The window Combo Box 

Properties will open. 

2. Open tab Values and click on the Edit button. The window Edit items 

will open. 

3. Select Use database values from the drop-down menu. 

4. Select NiceLabel Products under Database and Product Edition under 

Field and click on the OK button. The values tab in the window Combo 

Box Properties will show all the values of your database table. 

5. Click on the OK button. 

6. Repeat steps two (2) to five (5) with the Combo Box objects of prompts 

ProductID and Version and connect to the correct table of your 

database. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NiceForm: Links to Database Tables 
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7. Save the form by clicking on the  button or select command Save 

from the File menu. 

 

TIP:  If the printer you selected on the label template is connected to  

  your desktop computer, test print the form from your desktop  

  computer and do the following: 

a. Run the form by clicking on the  button or selecting the 

Run command in the Design menu. 

b. Type in the value for the first variable field (prompt5) and 

select the item from the Combo Boxes.  

c. Click on the Print button to print the label to the default 

printer.  

d. Click on the Quit button to close the running form. 

 

You can also link the form to an XLS file with multiple worksheets. The 

equivalent to the Access database above with three tables would be an XLS 

file with two (2) worksheets named NiceLabel Products and NiceLabel 

Version. 

Note: You cannot change the form using Pocket NiceLabel on your  

  Mobile Device. If you want to change the form or the database for 

  your Pocket NiceForm, you have to make the changes with  

  NiceForm and the database program on your desktop computer  

  and transfer the revised form file to the Mobile Device again.  

  Make sure that you delete the old form file from the memory of  

  your Mobile Device first before you transfer the new form (.XFF) 

  file with ActiveSync. 

4.5 Transfer Forms to Mobile Device 

After you have designed your label and form files on the desktop computer 

you have to transfer your form (.XFF) files from your desktop computer to 

your Mobile Device. NiceForm offers a synchronization wizard that uses 

the ActiveSync technology for your label and form transfers to the Mobile 

Device.  
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To transfer the form (.XFF) file to your Mobile Device, do the following 

steps: 

1. Save the open form file on your desktop. 

2. Go to File/ Save to Pocket PC… The window Pocket PC Conversion 

Wizard will open telling you the single steps of the file conversion. 

3. Click on the Next button and select the form file (.XFF) that you want 

to transfer to the Mobile Device. 

4. Click on the Next button and follow the instructions of the wizard. 

5. Read the summary of the wizard window Completing the Pocket PC 

Conversion Wizard and click on the Finish button to complete to file 

transfer to your Mobile Device. 

6. Click on the Close button when you see the following window: 

 

 

 

 

 

 

 

 

NiceForm has completed the form transfer to the Mobile Device. The 

.XFF file becomes a .PFF file on the Mobile Device. 

 

 

 

 

 

 

 

 

 

Form transfer with NiceForm 
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The folder My Labels on your Mobile Device should show the following 

 files: 

 

 

 

 

 

 

 

 

 

 

 

 

Open the My Label folder (in the My Documents folder) on your Mobile

 Device and check if all the .PFF, .LVR and .PNL files have been 

 synchronized successfully. 

 

You should now be able to open and print the form with your Mobile 

 Device using Pocket NiceLabel. 

 

Note: You cannot change the form (.XFF) file using Pocket NiceForm 

  on your Mobile Device. If you want to change the form, you have 

  to make the changes with NiceForm on your desktop computer  

  and transfer the modified form (.XFF) file to the Mobile Device 

  again. Make sure that you delete the old file from the memory of 

  your Mobile Device first before you transfer the new form (.XFF) 

  file from your desktop computer to the Mobile Device. 

 

Synchronized Files on Mobile Device 
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5. Printing Labels with Pocket 
NiceLabel 

You must transfer all necessary label, form and database files to your 

Mobile Device before you can print the labels and forms with Pocket 

NiceLabel. Pocket NiceLabel offers three (3) types of label printing 

methods: direct, distributed (print server) and print engine printing method. 

5.1 Direct Printing Method 

With the Direct Printing Method you print labels directly from the Mobile 

Device that is connected to the printer through Bluetooth, WiFi, or serial 

cable. You can print labels (.PNL files) and forms (.XFF files) using Pocket 

NiceLabel. 

5.1.1 Select Communication Port between Printer and Mobile 

Device 

On your Mobile Device, select the port that connects your Mobile Device 

with the printer you want to print the labels. You have three (3) port 

options for the direct printing method:  

 TCP/IP port:  Select this port if you want to print to the printer  

   using the TCP/IP protocol. Please note that the  

   printer must be equipped with a wireless network  

   card or be connected directly to the network. The  

   printer must have its own IP address and the port 

   must be known for the incoming connection. 

 Bluetooth: Select this option if you want to print labels using the 

   Bluetooth wireless protocol. In the Bluetooth 

   properties on the Mobile Device, you must define a 

   mapping to a virtual COM port through the  

   Bluetooth administration tool. Select the appropriate 

   mapped COM port. The printer has to be in range of 
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   the Bluetooth printer. Check the operating manual of 

   your Bluetooth device for effective distances. 

 COM port: Select this port if your printer is connected to the  

   serial port on the Pocket PC device. Set the required 

   connection parameters. The parameters on the printer 

   should be the same as on the Mobile Device. 

 

To select the port on your Mobile Device using Pocket NiceLabel, do the 

following steps: 

1. On your Mobile Device, tap on Start/ Programs/ Pocket NiceLabel/ 

Pocket NiceLabel. Pocket NiceLabel will open. 

2. Tap File/ Set Output Device and a new window will open.  

3. Select the port of your choice and tap the Settings button to define the 

settings.  

 

 

 

 

 

 

 

 

 

 

 

 

4. Tab the OK button twice to finish connection settings. 

 

 

 

 
Mobile Device: Communication Ports 
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5.1.2 Print Label File with Pocket NiceLabel 

To print your label with Pocket NiceLabel, please note that you must 

follow certain requirements when you design your label (.PNL file) for 

Pocket NiceLabel using NiceLabel Pro (see Designing Labels for Pocket 

NiceLabel). 

 

Select printer at the time of label design (NiceLabel Pro) 

When you design the label (.PNL file) make sure you select the printer you 

want to print the label with your Mobile Device. The label file will only 

print from the Mobile Device with the printer you selected when you 

designed the label with NiceLabel Pro. Because the Mobile Device does 

not have NiceDrivers installed you cannot change the printer assigned to 

the label using your Mobile Device with Pocket NiceLabel if you use the 

direct printing method. 

To be able to design the label with the correct printer assigned to it, you 

must install the printer driver (NiceDriver) on the computer you design the 

label with even though the printer is not connected to that computer. 

 

Print labels with Pocket Nicelabel from Mobile Device 

To print the label with your Mobile Device using Pocket NiceLabel, do the 

following steps: 

1. Export the label files (.PNL and 

.LVR) to your Mobile Device (see 

above). 

2. On your Mobile Device, tap on 

Start/ Programs/ Pocket 

NiceLabel/ Pocket NiceLabel. 

Pocket NiceLabel will open. 

3. Tap File/ Open and select Label 

files under Type. 

4. Tap the label file you want to 

print. 

 Pocket NiceLabel: Open Label 
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5. You will see the following information on the screen:  

 

 

 

 

 

 

 

 

 

 

 

 

6. Enter the required information. You must enter a value for all the 

variable prompts. 

7. Tap the Print button to print the label. 

5.1.3 Print Form File with Pocket NiceLabel 

Printing form files is a very user-friendly method to print labels (here 

forms) with a Mobile Device. You design a file with NiceForm (on your 

desktop computer) that has a data entry interface or application printing 

interface and includes all possible variable values. The operator in the field 

only has to select the values from a drop-down menu (combo box) to 

initiate a print job with the Mobile Device. Printing form files simplifies 

data input, reduces input errors and reduces errors in data collection and 

label printing. 

Select form preferences on your Mobile Device 

On your Mobile Device, select to override the application settings so that 

the Pocket NiceLabel application overwrites the .XFF file settings by doing 

the following steps: 

1. On your Mobile Device, tap on Start/ Programs/ Pocket NiceLabel/ 

Pocket NiceLabel. Pocket NiceLabel will open. 

 
Pocket NiceLabel: Print Label 
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2. Tap File/ Set Output Device and a new window will open.  

3. Check the box Override Application settings.  

 

 

 

 

 

 

 

 

 

 

 

 

4. Tap the OK button to close the window. 

 

To print the label with your Mobile Device using Pocket NiceForm, do the 

following steps: 

1. Export the form file (.XFF) to your Mobile Device (see above). The 

.XFF file becomes a .PFF file on the Mobile Device. 

2. On your Mobile Device, tap on Start/ Programs/ Pocket NiceLabel/ 

Pocket NiceLabel. Pocket NiceLabel will open. 

3. Tap File/ Open and select Form files under Type. 

4. Tap the form file you want to print. 

5. Enter and select the required information.  

6. Tap the Print button to print the form. 

 

 

 

 
Mobile Device: Application Settings 
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Pocket NiceLabel: Print Form 

 
Pocket NiceLabel: Enter Form Data 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.2 Distributed (Print Server) Printing Method  

With the Distributed (Print Server) Printing Method you print labels from 

the Mobile Device to NiceWatch, which handles printing and enables 

selection of different printer drivers. Pocket NiceLabel becomes a client to 

NiceWatch, which is the automated label-printing server running on a PC 

or a server.  

Pocket NiceLabel will output a print request that describes the label layout 

and the printing process, encode this information to a .JOB file using 

NiceCommands and send the .JOB file to a file trigger or a TCP/IP socket 

in NiceWatch. NiceWatch processes the .JOB file and prints the label to 

any available network printer. 

Using the distributed (print server) printing method allows you to select the 

printer type and format at the time of printing versus at the time of label 

design. Because NiceLabel Pro is running on the print server at the same 

time as the labels are printed, there are no design limitations as discussed 

under the direct printing method. You can use all the NiceLabel Pro and 

NiceForm functionalities, such as true type font for both fixed text objects 

and objects using variables. 
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If you want to use the distributed (print server) printing method, you can 

either print label (.LBL) files created with NiceLabel Pro or form (.XFF) 

files created with NiceForm from a printer on your network. However, 

using form (.XFF) files created with NiceForm is the recommended 

application because of its ease-of-use for the operator in the field. The 

following sections will focus on the distributed (print server) printing 

method using NiceWatch, NiceForm and form file printing with Pocket 

NiceLabel.  

To set up the distributed (print server) printing method, you need to do the 

following steps: 

 Select the communication port of your Mobile Device and Print 

Server. 

 Setup NiceWatch on your server or computer where the NiceLabel 

software is installed.  

 Select the correct form (.XFF) file properties. 

5.2.1 Select Communication Port between Print Server and 

Mobile Device 

On your Mobile Device, select the port that connects your Mobile Device 

with the printer you want to print the labels. You have two (2) port options 

for the distributed (print server) printing method:  

JOB file:  A .JOB file will be created and saved to the defined  

   network drive location into a customized filename. The  

   .JOB file contains NiceCommands describing the label you 

   want to print, the network printer you want to use and the 

   data for the label. NiceWatch, which runs on the server, will 

   detect the file drop and initiate the .JOB file to be processed 

   and printed by the NiceWatch printing server. 

JOB TCP/IP: As discussed with the previous option, a .JOB file is created 

 and then sent to NiceWatch using the TCP/IP protocol.  

 NiceWatch accepts the incoming connection on a  

 predefined TCP/IP port and processes the NiceCommands 

from the file. The NiceWatch printing server will print the 

labels. 
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To select the port on your Mobile Device using Pocket NiceLabel, do the 

following steps: 

1. On your Mobile Device, tap on Start/ Programs/ Pocket NiceLabel/ 

Pocket NiceLabel. Pocket NiceLabel will open. 

2. Tap File/ Set Output Device and a new window will open.  

3. Select either JOB File or JOB TCP/IP and tap the Settings button to 

define the settings.  

 

 

 

 

 

 

 

 

 

 

 

 

4. Enter the required information for path/ name or host/ port. See example 

in figure below. 

 

 

 

 

 

 

 

 

 

 

 

 
Distributed Printing: JOB TCP/IP 

 
Distributed Printing: JOB File 
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5. Tab the OK button twice to finish the connection settings. 

5.2.2 Setup NiceWatch for Distributed (Print Server) Printing 

Method  

NiceWatch is a module of the NiceLabel Suite edition that monitors events 

and automatically starts label production when specific (trigger) events 

occur. Trigger events can occur through a trigger file, an email, TCP/IP 

socket connection or COM port activity. NiceWatch can watch up to 99 

events each with their own specified action. NiceWatch executes a pre-

defined activity, such as label printing through a network printer, if one or 

more of such trigger events occur. You can use NiceWatch and start 

automatic label production on your computer where the NiceLabel software 

is installed or from your network. 

For a detailed discussion about NiceWatch, please see the NiceWatch User 

Guide on our Web site at www.nicelabel.com.  

If you want to print labels on a remote print server using your Mobile 

Device, you can set up NiceWatch with JOB file or TCP/IP triggers.  

 

 

 

 
JOB TCP/IP Settings 

 
JOB File Settings 
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JOB File Trigger 

A .JOB file specifies all the information required to print a label (label, data 

and printer). When you select the data with your Mobile Device and send 

the print job by tapping the print button, NiceWatch detects the dropped 

file in a specified folder, processes the data and prints the label(s) from the 

NiceWatch printing server. 

To set up a JOB file trigger with NiceWatch, do the following steps: 

1. Open NiceWatch (Go to Tools/ NiceWatch in the menu bar of your 

open NiceWatch software) and the NiceWatch Manager will open. 

2. Select Activities/ Start Server in the File menu or click on the icon  

in the standard toolbar. NiceWatch will start. 

3. Select New in the File menu or click on the icon  in the standard 

toolbar. 

4. Save the new configuration file as pnl-nwatch.mis. 

5. In the File menu bar, go to Edit/ Add Trigger/ File… or click on the 

icon  in the standard toolbar. 

6. Select the following options: 

i. File Trigger Options: enable trigger and select file name of your 

choice (here: File1) 

ii. Detecting Options: select Detect a set of files in the specified 

folder, click on the  icon and create a folder on your hard drive 

where all the job files will be dropped (here: C:\pnl-nwatch-

drop\) 

Note: Please make sure you change the properties of the   

  pnl-watch-drop folder. Go to the directory where the 

  folder is located, right-click on the folder, open the  

  Sharing tab and select Share this folder. Under   

  Permissions make sure you assign FULL CONTROL  

  to the user(s). Close the properties windows. The folder  

  icon should look like this: . 

iii. Execution Event: select Automatically detect changes in the 

folder 

7. In the open window Trigger Properties, click on the Variable tab. 
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8. Select Show internal variables. The window will show all internal 

variables. 

9. Select the variable DataFileName. 

10. Open the Actions tab and click on the Properties button. The Actions 

Editor window will open. 

11. Double-click on Run command file under Action Types/ Labeling. The 

window Action Properties [Run command file] will open.  

12. Select Variable job file name and DataFileName. Click on the OK 

button twice. 

13. Click on the OK button to close the window Trigger Properties. 

 

 

 

 

 

 

 

 

 

 

 

Now you have established a JOB file trigger with NiceWatch. In the next 

step you create a form (.XFF) file with the correct file properties. 

 

(JOB) TCP/IP Trigger 

A TCP/IP trigger works similar to a JOB file trigger. The Mobile Device 

sends the job file to NiceWatch trough the TCP/IP. NiceWatch accepts the 

incoming file on a pre-defined TCP/IP port and processes the label printing 

on the NiceWatch printing server. 

To set up a JOB file trigger with NiceWatch, do the following steps: 

 
NiceWatch with File Trigger 



 Chapter 5: Printing Labels with Pocket NiceLabel 

 

 

Pocket NiceLabel Quick Start Guide 39 

1. Open NiceWatch (Go to Tools/ NiceWatch in the menu bar of your 

open NiceWatch software) and the NiceWatch Manager will open. 

2. Select Activities/ Start Server in the File menu or click on the icon  

in the standard toolbar. NiceWatch will start. 

3. Save the new configuration file as pnl-nwatch.mis. 

4. In the File menu bar, go to Edit/ Add Trigger/ TCP/IP… or click on 

the icon  in the standard toolbar. 

5. Select the following options: 

i. TCP/IP Trigger Options: enable trigger and select file name of 

your choice (here: TCP/IP1) 

ii. Detecting Options: Enter port number of the computer/ server 

where NiceWatch is running (here: 1027) 

iii. Execution Event: select When client disconnects 

6. In the open window Trigger Properties, click on the Variable tab.  

7. Select Show internal variables. The window will show all internal 

variables. 

8. Select the variable DataFileName. 

9. Open the Actions tab and click on the Properties button. The Actions 

Editor window will open. 

10. Double-click on Run command file under Action Types/ Labeling. The 

window Action Properties [Run command file] will open.  

11. Select Variable job file name and DataFileName. Click on the OK 

button twice. 

12. Click on the OK button to close the window Trigger Properties. 

 

 

 

 

 

 

 



Chapter 5: Printing Labels with Pocket NiceLabel  

 

 

40 Pocket NiceLabel Quick Start Guide 

 

 

 

 

 

 

 

 

 

 

 

 

Now you have established a TCP/IP trigger with NiceWatch. In the next 

step you create a form (.XFF) file with the correct file properties. 

5.2.3 Create Form (.XFF) File for Distributed (Print Server) 

Printing Method 

Before you print labels using the NiceWatch printing server, change the 

form file pocketnl-form.xff you created above in the following two ways: 

 Add a Select Printer combo box with NiceForm so that you can pick 

the printer of your choice when you send the print job with your 

Mobile Device. 

 Change the form properties with NiceForm to enable distributed 

(print server) printing with your Mobile Device. 

Open NiceForm on your desktop computer and do the following steps: 

1. Open the file pocketnl-form.xff (see above). 

2. In the menu bar, go to Data/Variables… The window Variables will 

open. 

3. Click on the Add button. A new window will open. 

4. Enter Printer in the Name text box and click on the OK button. 

5. Click on the Close button to close the Variables window. 

 
NiceWatch: TCP/IP Trigger 
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6. On the toolbox menu click on the Combo Box button and select 

Existing Variables/ Printer. Place the combo box object on the form.  

7. Double-click on the printer combo box. The window Combo Box 

Properties will open. 

8. Open the Values tab and click on the Edit button. A new window Edit 

items will open. 

9. Select Use names of installed printers from the drop-down menu and 

click on the OK button. The Values tab of the Combo Box Properties 

window will show all the printer drivers you have installed on your 

computer. 

10. Select and delete the printer drivers you do not want to use with your 

Mobile Device. Click on the OK button to close the window. 

11. On the toolbox menu click on the Text button and place the text object 

on the form above the printer combo box. A new window Text 

Properties will open.  

12. Enter Select Printer in the Contents tab as a fixed text value and click 

on the OK button. 

13. Double-click on the Print button of the form. The window Button 

Properties will open. 

14. Open the Actions tab and click on the Edit button. The window Actions 

Editor will open. 

15. Select Set printer under Action Types and drag Set printer to the right 

window panel. Place Set printer under the first action Open label. The 

window Action Properties [Set printer] will open. 
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16. Select Variable printer name and select the printer variable. 

 

 

 

 

 

 

 

 

 

 

 

 

17. Click the OK button three times to close all button properties windows. 

 
NiceForm: Set Printer Action Properties 

NiceForm: Actions Editor Set Printer Variable 

 



 Chapter 5: Printing Labels with Pocket NiceLabel 

 

 

Pocket NiceLabel Quick Start Guide 43 

18. Save the form by clicking on the  button or select command Save 

from the File menu. 

TIP:  If the printer you selected on the label template is connected to  

  your desktop computer, test-print the form from your desktop  

  computer and do the following: 

a. Run the form by clicking on the  button or selecting the 

Run command in the Design menu. 

b. Enter the values for the variable fields from the Combo Box 

items.  

c. Select the printer you want to print the label with. 

d. Click on the Print button to print the label.  

e. Click on the Quit button to close the running form. 

 

To change the form file properties using the JOB file option, do the 

following steps: 

1. Go to File/Form Properties... The window Form Properties will 

open. 

2. Open the Distributed Printing tab and select the following: 

i. Enable distributed printing 

ii. Save commands to .JOB file 

3. Enter the path to your drop folder that you created with NiceWatch 

above and add the file name pnl-nwatch.job (here: \\dhb61851\pnl-

nwatch-drop\pnl-nwatch.job). [Please note that the path name starts 

with your computer/ server name, which is in this example dhb61851]. 

4. Click on the OK button and save the form by clicking on the  button 

or select command Save from the File menu. 
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To change the form file properties using the TCP/IP option, do the 

following steps: 

1. Go to File/Form Properties… The window Form Properties will 

open. 

2. Open the Distributed Printing tab and select/ enter the following: 

i. Send commands via TCP/IP protocol 

ii. Host: enter host IP address of the computer/ server where 

NiceWatch is running (here: 192.168.0.101) 

iii. Port: enter port number of the computer/ server where NiceWatch 

is running (here: 1027) 

3. Click on the OK button and save the form by clicking on the  button 

or select command Save from the File menu. 

 

 

 

 

NiceForm: Form Properties JOB File Option 
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5.2.4 Print Labels with the Distributed (Print Server) Printing 

Method  

To print labels with your Mobile Device using the distributed (print server) 

printing method, do the following steps: 

 Make sure NiceWatch is running with the settings you established 

above Setup NiceWatch for Distributed (Print Server) Printing 

Method. 

 Transfer the modified form (.XFF) file above (here: pocketnl-

form.off; see chapter Transfer Forms to Mobile Device). 

 Change properties on your Mobile Device as discussed in chapter 

Select Communication Port between Print Server and Mobile 

Device.  

 Open the form (.PFF) file on your Mobile Device, enter the data you 

want to print and tab the Print button. 

To change properties on your Mobile Device, do the following steps: 

 

 

NiceForm: Form Properties TCP/IP Option 
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1. On your Mobile Device, tap on Start/ Programs/ Pocket NiceLabel/ 

Pocket NiceLabel. Pocket NiceLabel will open. 

2. Tap File/ Set Output Device and a new window will open.  

3. Select either JOB File or JOB TCP/IP and tap the Settings button to 

define the settings.  

 

 

 

 

 

 

 

 

 

 

 

 

4. Enter the required information for path/ name or host/ port. Make sure 

you enter the same information as discussed in chapter Create Form 

(.XFF) File for Distributed (Print Server) Printing Method. See 

example in figure below. See example in figure below. 

 

 

 

 

 

 

 

 

 

 

 

 
Distributed Printing: JOB TCP/IP 

 
Distributed Printing: JOB File 
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5. Tab the OK button twice to finish the connection settings. 

 

To print the label with your Mobile Device using the form (.PFF) file, do 

the following steps: 

1. Transfer the form file (.XFF) to your Mobile Device (see above). The 

.XFF file becomes a .PFF file on the Mobile Device. 

2. On your Mobile Device, tap on Start/ Programs/ Pocket NiceLabel/ 

Pocket NiceLabel. Pocket NiceLabel will open. 

3. Tap File/ Open and select Form files under Type. 

4. Tap the form file you want to print. A new window will open showing 

the form with the variable combo boxes (see figure below). 

5. Enter and select the required information.  

6. Tap the Print button to print the form. 

 

 

 

 

 

 
JOB TCP/IP Settings 

 
JOB File Settings 
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Pocket NiceLabel: Print Form 

 
Pocket NiceLabel: Enter Form Data 

 

 

 

 

 

 

 

 

 

 

 

5.3 Print Engine Printing Method 

The Pocket NiceEngine (PNE), short Print Engine, is a .NET Assembly  

that allows other applications on the Mobile Device to control label 

printing  functions. Application developers do not need to write an 

embedded printer code or communicate with the operating system‟s I/O. 

The Windows Mobile Device can print labels using NiceLabel as the print 

engine that will process opening of .LVR, .PNL and .XFF files and printing 

of labels to printers on the TCP/IP, Bluetooth and COM (serial) ports. 

Pocket NiceEngine, which is embedded in Pocket NiceLabel, functions as 

an integrated print engine for any data collection application on your 

Mobile Device. 

The Pocket NiceEngine (PNE) with Pocket NiceLabel also supports the 

distributed (print server) printing method. The print engine creates a .JOB 

file with specific label printing commands (NiceCommands) that is saved 

on the computer or server where NiceWatch is running. The NiceWatch 

print server executes the NiceCommands from  the .JOB file (see chapter 

Distributed (Print Server) Printing Method). 

For more information about Pocket NiceEngine and .NET programming, 

see the Pocket NiceLabel Programming Guide available for download from 

the NiceLabel Web site at www.nicelabel.com. 
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6. Trouble Shooting with Pocket 
NiceLabel 

The following chapter will not all address all the error messages you might 

encounter using Pocket NiceLabel. If you do not find an answer to your 

error, go to the support section of the NiceLabel Web site at 

www.nicelabel.com or contact the vendor you purchased the NiceLabel 

software. 

6.1 Exporting and Synchronization Issues 

Issue:  Export to Pocket PC with NiceLabel Pro does not work. No 

   .LVR and .PNL files are created in the My Labels folder. 

Solution: Before you export the .PNL file, make sure that the data  

   input fields are empty. If you have printed the .LBL file  

   with entered data or printed a form .XFF file that bases on 

   the .LBL file, the label .LBL file stores the input data in the 

   memory. In such a case, you need to close and open the  

   .LBL again before you export it to the Mobile Device. 

 

Issue:  Export to Pocket PC shows the error message: “True type 

   text must not be variable!” 

Solution: If you want to print labels with your Mobile Device using 

   Pocket NiceLabel, remember that you must use native  

   printer fonts for variable objects. See chapter Designing  

   Labels for Pocket NiceLabel. 
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6.2 Label Printing Issues with Mobile Device 

Issue:   Label does not print or wrong variable prompts are  

   displayed. 

Solution:  Transfer label to the Mobile Device again but follow these 

   steps: 

1. Delete the Pocket NiceLabel files (.PNL, .LVR, and 

.XFF files) from the memory or turn off the Mobile 

Device (suspend for Windows .Net devices). 

2. Delete files in Synchronization folder on your 

desktop computer. 

3. Export file from NiceLabel Pro. 

4. Synchronize with Mobile Device and start printing 

from Mobile Device. 

 

Issue:  Mobile Device displays error message: 

“Directory(\\computername\dropfolder\) is not accessible or 

does not exist!” 

Solution: If you are using the JOB file trigger option for distributed 

  (print server) printing method (see chapter Setup   

  NiceWatch for Distributed (Print Server) Printing 

  Method) create or change the settings of the folder on your 

  hard drive where all the job files will be dropped (for  

  example: C:\pnl-nwatch-drop\).  

To change the folder‟s preferences, do the following steps:  

1. Go to the directory where the folder is located (for 

example: C:\pnl-nwatch-drop\). 

2. Right-click on the folder. 

3. Open the Sharing tab and select Share this folder. 

4. Click on the Permissions button and assign FULL 

CONTROL to all the users. 

5. Click on the OK button twice to close the properties 

windows. The folder icon should look like this: . 
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Issue:  Mobile Device displays error message: “Cannot write to file 

   (\\computername\dropfolder\jobfile.job)!” 

Solution: See above. Check sharing and permission rights for the  

   drop folder. 

 

Issue:  Mobile Device displays error message: “Connection to the 

   server (xxx.xxx.x.xxx:xxx) cannot be established.” 

Solution: Check the following setup configuration: 

1. Enter the correct server IP address and port number 

of the computer/ server where NiceWatch is running 

under options/preferences of your Mobile Device. 

2. Enable or run the TCP/IP trigger setup in NiceWatch 

(for example, check the box in the row of your 

TCP/IP trigger name in NiceWatch; see NiceWatch 

figure above). 

 

Issue:  Mobile Device displays error message: “Engine Error!  

   Cannot use this function from selected type of printing.” 

Solution: Check the preferences under options on your Mobile  

   Device and make sure that you have selected the correct  

   port (for example, JOB TCP/IP  versus TCP/IP port) for  

   your selected printing method (direct versus  distributed  

   printing). 
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7. Technical Support 

If you experience any technical difficulties using the NiceLabel software, 

refer to the on-line help and User Guides available on the NiceLabel CD. 

You will find a comprehensive How to section that explains how to use the 

NiceLabel software. 

7.1 Online Support 

You can find the latest builds, updates, workarounds for problems and 

Frequently Asked Questions (FAQ) under the support section on the 

product web site at www.nicelabel.com. If you cannot solve the problem 

on your own, please contact your local vendor or representative offices 

listed in the chapter Contact Information.  

For more information please refer to: 

Support FAQ:  www.nicelabel.com/support/support_faq.php 

NiceLabel FAQ: www.nicelabel.com/nicelabel/nlbl_faq.php 

NiceLabel Tutorials: www.nicelabel.com/support/support_tutorials.php 

 

7.2 Contact Information 
 

Head Office:   

Euro Plus d.o.o. 

Poslovna cona A 2 

SI-4208 Šenčur 

Slovenia 

Tel: +386 4 280 50 00 

Fax: +386 4 233 11 48 

support@nicelabel.com 

http://www.nicelabel.com 

  

mailto:support@nicelabel.com
http://www.nicelabel.com/
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German Office   

NiceLabel Germany GMBH 

Liebknechtstr. 29 

63179 Obertshausen 

Tel:+49 (0)6104 405 400 

support@nicelabel.de 

http://www.nicelabel.de 

 

North American Office 

 

Niceware International, 

LLC 

200 South Executive Drive, 

Suite 200 

Brookfield, Wisconsin 

53005 

USA 

Telephone: (888) 894-NICE 

(6423) 

Fax: (262) 784-2495 

E-mail: 

sales@nicewareintl.com , 

support@nicewareintl.com  

Web:www.nicewareintl.com  

 

  

 

 

  

mailto:support@nicelabel.de
http://www.nicelabel.de/
mailto:sales@nicewareintl.com
mailto:support@nicewareintl.com
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8. Index 

A 

ActiveSync. See Synchronize 

B 

Bluetooth, 28 

C 

Client Access License (CAL). See 

Registration 

COM Port, 29 

Combo Box. See Object 

Concatenation. See Functions 

Currency Exchange. See Functions 

D 

Database Connection, 22 

Date Addition. See Functions 

Demo Mode. See NiceLabel 

Design, Label. See Label Design 

Direct Printing. See Printing Method 

Distributed Printing. See Printing 

Method 

E 

EAN.UCC 128. See Functions 

Export. See Synchronize 

F 

Form. See Label Design, Form 

Functions, 13 

Concatenation, 13 

Currency Exchange, 13 

Date Addition, 13 

EAN.UCC 128, 13 

Internal Printer Clock, 13 

Internal Printer Counters, 13 

Linear, 13 

Subset, 13 

I 

Installation, 7, 8 

Installation Wizard, 8 

Internal Printer Clock. See Functions 

Internal Printer Counters. See 

Functions 

J 

JOB File, 34, 43 

JOB TCP/IP, 34 

L 

Label Design 

Form, 18, 40 

NiceForm, Using, 17 

NiceLabel Pro, Using, 14 

Overview, 12 

Label Printing. See Printing Method 

Linear. See Functions 

M 

Mobile Device 

Printing (with Pocket NiceForm), 31 

Printing (with Pocket NiceLabel), 30 
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Printing, Direct, 29 

Setup and Testing, 5 

Windows CE, 5 

N 

Native Font, 14 

NiceDriver, 15 

NiceEngine. See Printing Method, Print 

Engine 

NiceForm. See NiceLabel 

NiceLabel 

Demo Mode, 9 

NiceForm, 4, 17 

NiceLabel Pro, 4 

NiceLabel Suite, 4 

NiceMemMaster, 5 

NiceWatch, 5 

Pocket PC Designer, 4 

NiceLabel Pro. See NiceLabel 

NiceLabel Suite. See NiceLabel 

NiceMemMaster. See NiceLabel 

NiceWatch. See NiceLabel, Distributed 

Printing 

O 

Object 

Combo Box, 20 

NiceForm, Supported with, 18 

P 

Pocket NiceForm, 18, 31 

Pocket NiceLabel 

Overview, 3 

Print Server Printing. See Printing 

Method, Distributed 

Printer Driver. See NiceDriver 

Printing. See Printing Method 

Printing Method 

Direct Printing, 12, 28, 30, 31 

Distributed Printing, 3, 33, 36, 45 

Print Engine, 4, 48 

R 

Registration, 10 

Client Access License (CAL), 10 

Resident Font. See Native Font 

S 

Subset. See Functions 

Support, 52 

Synchronize 

ActiveSync, 16, 25 

System Requirements, 7 

T 

TCP/IP, 28, 44 

Transfer Files. See Synchronize 

W 

Windows CE. See Mobile Device 

 

Exported 
Files on 
Mobile 
Device 


